
WHAT IS EXTENSIS PORTFOLIO™?
Portfolio is an electronic media cataloging tool that gives you quick, easy, and efficient ways to organize,
browse, manage, retrieve, and use files containing digital data. 

Portfolio catalogs all types of digital files and images, regardless of the file format, file location, or the appli-
cation used to create the file. Cataloged files can be viewed as thumbnails or by list, and information about
the image file, such as size, type, creation date, location, and other data are available at the click of a button.
Keywords and other search criteria help you quickly locate, access, and reuse your digital files. And handy
drag and drop functions give you easy ways to transfer, copy, or place cataloged images.

HOW CAN PORTFOLIO HELP ME?
Portfolio makes quick work of finding and retrieving still images and multi-media. 

Use Portfolio to keep visual catalogs of: 
• All the art and photographs used in a newsletter, brochure, manual, or presentation.
• Artwork, pictures, scans, movies, sounds, and even 3D images that you may want to use repeatedly in

different projects, including all your stock and royalty free art on CD-ROM disks. 
• Artwork created by your family for use in greeting cards, letters, and holiday projects.
• Miscellaneous pieces of clip art for quick and convenient reference and use.

Or use catalogs to visually distinguish similar images, such as different sizes, colors, or content of a masthead
or logo, or where file names alone are not enough to describe images. And it’s really simple to do—simply
drag and drop your files into open Portfolio windows to create, add to, and update catalogs. You can even
drag and drop items right from the catalog into documents that you create in other programs that support
this feature, such as QuarkXPress, PageMaker 6.5, and ClarisWorks. And because Portfolio catalogs capture
only a thumbnail image of each cataloged file and not the file itself (keeping instead a “link” to the file’s
location), cataloging images with Portfolio takes up much less space than copying images into a scrapbook.

HOW CAN THIS QUICK START GUIDE HELP ME?
If you’re new to Portfolio, you can use this guide as a quick way to get “up and running.” But even if you’re
an old hand at creating and using Portfolio catalogs, you may find some exciting new features here. When
you’ve finished with this guide, you’ll know enough about Portfolio to create and use simple catalogs, and
you’ll be aware of some of the more commonly used features. To learn more about Portfolio and the many
options and features available, refer to your Extensis Portfolio User Guide and to the ReadMe files in your
Portfolio application folder.
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THE SAMPLE CATALOG
A Sample Catalog—located on the Extensis CD—includes samples of the types of images that can be cata-
loged and viewed with Po rt f o l i o. You can use this sample catalog to experiment with the different feature s
highlighted in this guide.

PORTFOLIO BASICS: CATALOGS AND GALLERIES
Catalogs: When items are cataloged in Portfolio, a record is created for each one, and information about the
item is stored in this record. Item information can include keywords, descriptions, and custom fields that
you create, as well as the item thumbnail, source file name, creator, creation date, source file location, and
other key information gathered by Portfolio automatically when the item is cataloged. A catalog is therefore a
collection of records that provides information about the items contained in it.

Galleries: When you view cataloged items in Portfolio you are actually viewing the information contained in
each item’s record, such as the item thumbnail, description, and keywords. Your window to these records is
called the Gallery. The Gallery is the main window in Portfolio, and a Gallery window is opened automati-
cally each time you open a catalog. A Gallery can contain all or any subset of the items in the catalog. There
are three different Gallery views (shown on page 1): Thumbnail View, List View, and Record View. Having
access to different views allows you to display and view catalog records in a variety of ways. Each view can be
easily customized to show just the type and amount of data that you want to display. You can organize the
records in your Galleries by sorting and rearranging them; you can even enhance them by adding a back-
ground color and thumbnail borders. 

The Toolbar: A handy Toolbar provides one-click access to the most commonly-used commands, including
switching between Gallery views, opening new or saved Galleries, customizing Galleries, and accessing the
Find options, including QuickFind, which allows you to search for cataloged items by keyword without
opening the Find command window. Place the mouse over each button to see the button description. Note:
The Windows and Macintosh Toolbars are slightly different. Both Toolbars are discussed in detail in the Portfolio
User Guide. 
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STEP 1: OPEN A NEW OR EXISTING CATALOG
Open the Portfolio application by double-clicking its icon. When the Welcome dialog appears, you can
choose to create a new catalog, open an existing catalog, or connect to a Portfolio Server catalog.  

New Catalog: If you choose to create a new catalog, click “Create a new Portfolio catalog,” then click “OK”
and choose a name and location for your new catalog. Portfolio creates a blank catalog and displays an
empty Gallery window.

Existing Catalog: To open an existing catalog (we recommend the Sample Catalog on the Extensis CD if
you do not have an existing Portfolio catalog), click “Open an existing Portfolio catalog,” then locate the
catalog you wish to open. You can specify a default catalog that will open automatically each time Portfolio
is launched (from the catalog you wish to use as the default, choose File > Set Default Catalog).

Connect to Server: If your network provides access to shared catalogs using separate Po rtfolio Se rver soft-
w a re, you can access those catalogs using the standard Po rtfolio application. To open a catalog on a Po rt f o l i o
Se rve r, click the “Open an existing Po rtfolio catalog” button, then click the “Connect to Se rve r” button. A
list of available servers will be displayed. If the list is empty or does not show the Se rver you want to connect
to, click “Add Se rve r,” then enter the name or IP address of the Se rve r. When the selected Se rver appears,
select a catalog from the list and click “Open Catalog.” A Ga l l e ry window from the selected catalog will be
d i s p l a yed. You can also connect to a Se rver using the “Connect to Se rve r” button on the Po rtfolio To o l b a r.

OPTIONAL: ADD ITEMS TO THE CATALOG
If you created a new catalog you will want to add some items to it.

To catalog items in Portfolio all you need to do is add them to an open Gallery window—Portfolio will do
the rest. You can add items to a catalog in three ways: by dragging and dropping them into an open Gallery
window; by choosing “Add Items” from the Catalog menu and then locating the items to be added; or by
copying them from another catalog. When you drag and drop the items, or choose the “Add Items”
command, you can add individual files or whole folders and volumes. In this way you can catalog an entire
volume in one step!

Cataloging Options: When you add items to a catalog, the Cataloging Options dialog is displayed,
allowing you to choose a variety of options to specify what information is collected when the items are
cataloged. You can examine the options available and change them, or simply click “OK” to accept the
settings and begin cataloging. If you prefer, you can keep the Cataloging Options dialog from opening each
time you add items by selecting the appropriate option under Edit > Preferences. 

Cataloging Status: Portfolio will begin cataloging the items and keep you posted on its progress by display-
ing appropriate information in the Cataloging Status dialog.

UP A N D RU N N I N G
W I T H PO RT F O L I O 4 . 0 VIEWING CATALOG ITEMS

3



UP A N D RU N N I N G
W I T H PO RT F O L I O 4 . 0 VIEWING CATALOG ITEMS

4

STEP 2: FIND AND DISPLAY CATALOGED ITEMS
You can search the catalog by dragging the Gallery scroll bars up and down, or you can speed your search
using Portfolio’s Find function . You can search any field, including Custom Fields and keywords. By
default Portfolio replaces the items currently being displayed in the Gallery with the results of the Find; you
can direct Portfolio to display the results in a new Gallery by clicking the “Display results in new Gallery”
box. You can reorganize the items in the window by dragging them to new locations. You can even delete
items from Gallery views without deleting them from the catalog. 

Find All: You can display all of the items in the catalog at once by clicking the “Find All” button. You can
also “Find All” by choosing this option from the Catalog menu, or by pressing Command+' (Mac OS) or
Ctrl+' (Windows).

Once you have displayed some or all of the cataloged items in a Gallery, you can preview, organize, and copy
them, customize the display, and much more (see page 5).

OPTIONAL: SEARCH USING KEYWORDS
A keyword is a word or phrase that you associate with a particular item, and a good keyword list can be a
valuable tool for finding the material you need in a catalog. Each catalog item can have an unlimited num-
ber of keywords associated with it. Item keywords are available for display in every Gallery view (choose
View > Customize) so that you can easily see which keywords are assigned to an item, and have easy access
to other items with the same keyword. The number to the right of the keyword indicates how many  other
items in the catalog have that keyword assigned. From the List and Record View you can have Portfolio
locate and display all the items with a particular keyword by double-clicking the desired keyword in the
Keywords list. All items with the selected keyword will be displayed in the active Gallery window. You can
also search for keywords using the QuickFind field on the Toolbar. You can add keywords to items that yo u
h a ve selected (by highlighting them in the Ga l l e ry window) by choosing Edit Ke y w o rds from the Item menu. 

Master Keywords List: If you create a list of Master Keywords for your catalog you can choose words from
the list to find and display catalog items. A list of Master Keywords is also helpful in ensuring consistency
when keywording, allowing you to add keywords to an item by selecting words from a pre-defined list. 

Ke y w o rding is described in detail in the Po rtfolio User Gu i d e .

OPTIONAL: CHANGE THE GALLERY VIEW
You can easily switch between Gallery views using buttons on the Toolbar. The three Gallery views are:
Thumbnail view , List view , and Record view .

KEYWORDSTHUMBNAIL DESCRIPTION
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CUSTOMIZING GALLERY VIEWS
Each view can be customized to show as much or as little information as you require. You can even
customize the way that thumbnails are displayed—changing the display size, adding background colors, and
even thumbnail borders. 

You can create multiple Galleries to display as many or as few cataloged items as you wish, drag and
drop items between Galleries, delete items from the Gallery without deleting them from the catalog, and
save Galleries by name for viewing at any time. This allows you to have a large number of items in a
catalog, yet be able to limit the view to a small number of specific items. 

WORKING WITH CATALOG ITEMS
When an item is being displayed in the Gallery window you can do almost anything with it that you can do
from the Finder (Mac OS) or Explorer (Windows), and more! 

Item Properties: From the Item Properties window you can view all of the information gathered about an
item, even if this information is not being displayed in the current Gallery view. To do so, select (highlight)
the item, then choose “Item Properties” from the Item Menu. You do not need to have access to the item’s
source file to display items in a Gallery or view Item Properties.

Item Preview: If the item is a still image (picture) you can view the image in an enlarged window. If the
item is a multimedia file (such as a 3-D image, movie, or sound) you can manipulate it or play it from the
Preview window. Note: You must have access to the item’s source file to preview it in Portfolio.

Source Files: If you have access to an item’s source file (the original file to which the catalog entry points)
you can work with the file just like you would in the Finder or Explorer. Doing so allows Portfolio to track
when an item’s source file has changed, making catalog updating easier. For example, from within the
catalog  you can:

• Switch to another program to edit the source file.
• Move, Copy, Delete, Find, or Rename the source file.
• Print thumbnails or the item itself.

These and other item commands are available from the Item menu.

Drag and drop to other applications: On the Macintosh, you can drag items from Gallery windows into
any application that supports drag and drop. Extensis provides drag and drop support for QuarkXPress with
a free extension “QX-Drag&Drop,” which is included on the Extensis CD. On Windows PCs, you can drag
and drop items from Gallery windows into any application that supports OLE drag-and-drop.

WO R K I N G W I T H CATA L O G IT E M S
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PRE-PLANNING YOUR CATALOGS
When creating a catalog, first decide what items you’d like to have in it. You can include documents, pieces
of art, photographs, sound files, movies, multimedia files, folders with items and/or other folders in them—
almost any electronic file can be cataloged! Just be aware that everything inside the folders will become a cat-
alog item. While you can catalog anything almost instantly, to make the best use of a catalog, we suggest that
you do a little planning before you start. To create a new catalog, see page 2.

ADDING ITEMS TO A CATALOG
You can quickly and easily add items to a new or existing catalog by dragging them from a folder window
and dropping them into the catalog Gallery window (as described on page 2), or by selecting the “Add
Items” command from the Catalog menu. If you add items from disks that may not always be available, such
as removable cartridges, CDs, or network volumes, you can dismount the drives and continue to use the cat-
alog—viewing, searching, and organizing catalog items—without remounting the volumes. If you select a
command that accesses the item’s source file (such as editing, copying, renaming), Portfolio will prompt you
to insert the necessary volume.

UPDATING ITEMS IN A CATALOG
Remember that Portfolio keeps only a thumbnail of the image in the catalog, and it looks for the actual file
when placing (dragging and dropping) images in other documents.  If you move the file associated with a
catalog image, you’ll need to make Portfolio aware of the move, and allow it to update that item information
in your catalog. If you do not, Portfolio won’t know where to find the image, and you’ll be limited in what
you can do with it—you won’t, for example, be able to copy the image to another document.

The easiest way to update Portfolio after you move a file is to select that file in the Finder or Explorer, then
drag it to the open catalog and select “Update” from the Catalog Options dialog that pops up. This updates
the link to the original file. 

Adding and Updating are discussed in detail in the Portfolio User Guide.
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SLIDESHOWS
You can view catalog images at their original size using the Sl i d e s h ow feature. The Sl i d e s h ow displays only the
images in the active Ga l l e ry window, so you can limit the Sl i d e s h ow to just the items you wish to show by cre-
ating a new Ga l l e ry and adding the desired images to it. You initiate the Sl i d e s h ow and access Sl i d e s h ow
options from the Catalog menu. You must have access to the item’s source file to display it in a slideshow. 

CUSTOM FIELDS AND URLS
All Po rtfolio catalogs consist of a number of predefined fields. These include keyword and description fields,
and “s y s t e m” fields, such as Filename, Path, Created, and so on. In addition to the predefined fields, you can
define Custom Fields to hold specialized information about catalog items. For instance, you might want to
add a field for Web site URLs to a catalog of GIF files, or a “Ph o t o g r a p h e r” field to a catalog of photographic
images. Once a Custom Field has been defined (Catalog > Administration: Custom Fields), you can add infor-
mation to it either by typing it into the item re c o rd (Item > Item Pro p e rt i e s : Fields), by extracting data fro m
the source file and mapping it to the appropriate Custom Field (Catalog > Cataloging Op t i o n s : Mappings), or
by importing the data from a text file you created with appropriate data (File > Im p o rt ) .

FIND AND REPLACE
You can add and replace keywords, descriptions, and Custom Field data for multiple items using the Replace
function. This allows you to select a number of items and replace key information for them all at once. To
access the Replace function, choose “Replace” from the Catalog menu.

IM P O RT I N G & EX P O RT I N G/ CR E AT I N G A WE B PA G E
You can import field values into Portfolio, such as keywords and data from other databases, and you can con-
vert entire Cumulus catalogs (Macintosh) to Portfolio.

Export options include the ability to: export catalogs as text files for input into a database; export “pnot”
data (Macintosh); and export selected items—or an entire catalog—as HTML Web pages. 

SCRIPTING
Portfolio supports AppleScript and other OSA-compliant scripting language (Mac OS) and OLE
Automation (Windows). The scripts or applications that you write to automate Portfolio can be conveniently
launched from within the catalog using a special Scripts menu that installs itself in the Portfolio menubar.

UP A N D RU N N I N G
W I T H PO RT F O L I O 4 . 0 ADDITIONAL OPTIONS

7



MULTIPLE USERS/CATALOG NETWORKING
Using standard system filesharing, you can share Portfolio Catalogs between users. In a network environ-
ment, a shared catalog can be on a network file server or on any user’s Macintosh or PC, as long as the
Macintosh or PC is properly networked. 

For better performance when sharing catalogs, and to allow more simultaneous users, special Portfolio Server
software is recommended. You create, access, manage, and administer served catalogs using the standard
Portfolio 4.0 application.

CATALOG SECURITY AND ACCESS LEVELS
Portfolio gives you control over who can make changes to catalog information using four levels of access:
Administrator, Publisher, Editor, and Reader. Each level can have its own password. Access levels are impor-
tant in a multi-user environment, or when you share your workstation with other users. 

Administrator level allows access to all catalog functions, including creating Custom Fields and editing the
Master Ke y w o rd List. Other users can enter data in the Custom Fields, and apply keywords to items from the
Master Ke y w o rds List, but only the Administrator can create Custom Fields and the Master Ke y w o rds List.

The Administrator is responsible for setting all access level passwords, and Administrator is the only access
level that can change passwords. When a catalog is created it is automatically given Administrator level
access, so that you will have access to all the features and functions necessary to set up the catalog. A shared
catalog cannot be accessed by other users when it is in use by the Administrator.

You can change catalog access level by choosing “Access” from the Catalog menu.
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LEARN MORE ABOUT PORTFOLIO
We’ve covered a number of Portfolio features in this guide, but the information presented was necessarily
limited. There’s much more information available both on the features presented here, and on the many
helpful features and options that we didn’t mention. We invite you to take advantage of the following
additional information sources covering Extensis Portfolio:

• Extensis Portfolio 4.0 User Guide
• Help—available from the Toolbar and the menubar
• ReadMe—a text file located in your Portfolio application folder with late-breaking information
• Sample Catalog—a catalog of images for you to play and practice with, located in the Portfolio folder on

the Extensis CD

ADDITIONAL PORTFOLIO PRODUCTS
If you have a large number of users, or to improve catalog responsiveness in a networked environment, we
recommend that you use special Portfolio Server software. The Portfolio Server is a small but powerful appli-
cation whose sole function is to serve catalogs; served catalogs are created, accessed, and managed using the
standard Portfolio application.

For information on the Portfolio Server application, site license information, or for information on creating
and publishing CD catalogs using the Extensis Content Publisher’s Toolkit and Portfolio Browser, contact
Extensis. In the USA call 800-796-9798, and ask for Corporate Sales. Or send E-mail to sales@extensis.com.
In Europe, telephone #31 (0)30 247 5050, or send E-mail to extensis@euronet.nl.

VISIT OUR WEB SITE / OTHER EXTENSIS PRODUCTS
For Frequently Asked Questions (FAQs), troubleshooting information, and other up-to-date information
about Po rtfolio, visit our web site at: http://www.extensis.com. 

In addition to Portfolio, Extensis offers an array of products that extend the capabilities of popular graphics
and layout applications such as QuarkXPress®, Adobe Photoshop®, Adobe Illustrator®, Adobe PageMaker®,
and Macromedia FreeHand™. Other Extensis product information is available from our web site. 
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EXTENSIS CORPORATION

USA
1800 S.W. First, Suite 500
Portland, OR 97201
Phone: 503-274-2020
Fax: 503-274-0530
E-mail: info@extensis.com
Internet: http://www.extensis.com

CUSTOMER SERVICE
Phone: 800-796-9798
E-mail: sales@extensis.com

TECHNICAL SUPPORT
Phone: 503-274-7030

Monday–Friday, 8am–5pm Pacific
E-mail: support@extensis.com

EUROPE
Zonnebaan 34
3606 CB Maarssen
The Netherlands
Telephone: #31 (0)30 247 50 50
Fax: #31 (0)30 241 20 39
E-mail: extensis@euronet.nl

Extensis and Extensis Po rtfolio are trademarks of Extensis Corporation. All other trademarks and re g i s t e red trademarks are the pro p e rty of their re s p e c t i ve ow n e r s .
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